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ABSTRACT 
Short wave infrared (SWIR) data derived from field-portable or benchtop hardware can provide 
useful vectors for mineral exploration. Acquisition of data with suitable QA-QC measures in place, 
capture of relevant metadata, database storage of raw data and processed results, and processing 
itself can be a barrier to uptake for new users and problematic for fusion of datasets even when 
this data is acquired by experienced practitioners. The intention of this walkthrough is to mitigate 
these issues by providing explicit and detailed guidance on these aspects of SWIR spectroscopy in 
the form of a practical workflow and attached templates and supplementary materials. 
It is our hope that adoption of protocols derived from this document will facilitate a greater 
conversation in academia and industry around the capture, storage, and interpretation of this sort 
of data, and lead to ever-improving data and interpretive quality for current and future practitioners 
to apply to mineral exploration or rock characterization problems. 

1. INTRODUCTION 
1.1 Objectives 
Welcome to the exciting world of (field portable) short-wave infrared (SWIR) and visible to near 
infrared (VNIR) spectroscopy! Presumably you’re reading this for one of two reasons: 

1) You’re a practitioner and are interested in implementing/contributing to establishment of 
standards and best practices for this technique. 

2) You’re new to this and would like to get started. 

Either way you are in the right place. 

This document and appendices are intended to provide a public domain guide for practitioners 
(perhaps in the mineral exploration industry, academia, or another field) to work toward 
standardizing the acquisition, storage, and interpretation of spectral datasets. It’s also intended to 
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be accessible to newcomers and provide step-by-step instruction. This is a first edition; readers 
are invited to submit suggestions to the authors for addition to future editions. 

1.2 The electromagnetic spectrum: starting at the start 
The electromagnetic spectrum (Figure 1) refers to the broad range of wavelengths of 
electromagnetic energy in the known universe, from long wavelength radio waves all the way 
down to short wavelength gamma waves. 

As human beings, our eyes register a small segment of this range, visible light (390 to 750 nm). 
Your food is heated in a microwave oven by another small segment. AM/FM radios pick up 
signals from another segment. Much of the technology around us is related to signals or energy 
transmitted and received using certain portions of the spectrum. 

 
Figure 1) From (Kerr et al., 2011) after (Hauff, 2008). The electromagnetic spectrum. showing the regions of interest for 
SWIR and VNIR spectroscopy. 

1.3 SWIR spectroscopy: what is it? 
The method examines a range of the electromagnetic spectrum from approximately 1300 – 2600 
nm, recently described as SWIR 1 (1300 – 1850 nm) and SWIR 2 (1850 – 2600 nm), 
differentiated by their vibrational modes (Laukamp et al., 2021). SWIR 2 extends to 2600 nm but 
most instrumentation reaches 2500 nm only. Certain bonds, primarily those involving oxygen or 
ammonium, vibrate when impacted by energy at specific wavelengths within this range, 
converting some of the incident energy into kinetic energy and therefore reflecting a modified 
spectrum with lower intensity at the corresponding wavelength (Figure 2 and Table 1). In 
practical terms, this means shining a light on a sample, capturing the reflected spectra, and 
processing it such that the absorption features reveal the composition of the sample by relating 
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the geometry of absorption features to a specific SWIR-active mineral or combination of such 
minerals.  

The scale of application, discussed herein focuses on spectra collected with field-portable 
instrumentation such as Spectral Evolution’s oreXpress or Malvern Panalytical’s ASD Terraspec 
models. Instruments like these typically expose a sample to a light source through a window of 
approximately 2 cm diameter (this varies by model and probe attachments), and then route the 
reflected light back to sensors and a processing unit to capture a spectrum. Spectra are ultimately 
downloaded from the unit and processed with a software to assign mineral matches through 
comparison with a library of reference spectra, and to extract geometric or spectral shape 
information for relevant absorption features, such as the width (or full width half maximum; 
FWHM), depth (D), and wavelength at minimum (W), as shown in Figure 2. These numeric 
representations of spectral geometry are referred to collectively as parameters or individually as 
scalars or indices. 

 
Figure 2) From (Trott et al., 2022). Examples of SWIR spectra extracted from the JPL Ecostress spectral library (Grove 
et al., 1992), showing key absorptions for the three minerals discussed as vectors. B) Insert illustrates the nomenclature of 
absorption feature scalars applied to the 2200nm "AlOH" absorption for muscovite. The exact value of the wavelength in 
nanometers at its minimum is represented by W. Depth (D) is measured from the base of the absorption (the minimum) 
vertically to where it intercepts the Convex Hull line, formed by connecting apices along the spectral curve. FWHM is 
measured at the midpoint of D, between either side of the absorption. 

SWIR sensing technology is applied at various other scales in the mineral exploration industry. 
Satellite multispectral systems such as Landsat and ASTER apply the same principles, although 
at much coarser wavelength and spatial resolutions. In areas of abundant outcrop these satellite-
borne methods may be useful for identifying the geometry of large alteration zonation patterns or 
systematic variations in mineral chemistry (Bedell et al., 2009). At an intermediate scale, 
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airborne hyperspectral systems (e.g., HyMap) may be applied for greater spatial and spectral 
resolution than satellite systems, and broader coverage than handheld systems (Cudahy et al., 
2001). In many cases, handheld methods and airborne or satellite systems are used in 
conjunction, whereby handheld measurements contextualize results by constraining the spectral 
response of representative samples from a larger area of study (Lampinen et al., 2017). 

In recent years SWIR acquisition has been applied using core scanning techniques, in essence 
producing a spatially related string of spectra (e.g., HyLogger) or a spectra per ‘pixel’ as opposed 
to localized point readings (e.g., CoreScan or Terracore platforms). These instruments provide 
exponentially more information but may come with some drawbacks. Some of them, particularly 
those with a high resolution, tend to be large and costly to mobilize and operate, and produce 
heavy datasets (on the order of terabytes) which may be unwieldy to process and interpret 
without highly specialized knowledge about SWIR methods AND access to cloud or cluster 
computing. 

 
Table 1) Modified from (Hauff, 2008; Laukamp et al., 2021). Major absorption features in the SWIR range. Absorption of 
energy occurs at these wavelength positions depending on the presence of the bonds listed under "Mechanism". 

1.4 Absorption Geometry and Scalars 
A spectrum consists of numerous ‘bands’ of relative reflectance/absorbance information. A 
spectrum not only facilitates mineral identification, but also quantifies often overlooked spectral 
characteristics such as absorption feature position, width, and depth, as shown in Figure 2, and 
ultimately mineral compositions. Software is used to extract and numerically represent these 
features in a semi-automated fashion. Each scalar extracts a single predefined feature from the 
spectrum in question, or calculates a value based on other scalar outputs. An extracted scalar 
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value numerically represents some mineralogical aspect of the sample. Although several 
software solutions for this purpose are available, this document is focused on usage of The 
Spectral Geologist (TSG), described further in Section 5.2. 

The relative depths (in reflectance %) of absorption features (D-prefixed scalars) are measured 
vertically from the minimum point up to where it intercepts a background, or Convex Hull, as 
shown in Figure 2 inset B. The convex hull is a reference line (may be thought of as a piece of 
string draped across a spectrum) made by fitting a downward concave curve to the overall trend 
of the un-normalized spectral peaks on either side of an absorption feature. From this the Hull 
Quotient (HQ) curve (or a normalized version of our spectrum) is calculated by dividing the 
original reflectance by the convex hull. In other words, the depth of an absorption feature needs 
to be measured against a ‘roof’ and the HQ curve is a broadly accepted means of assigning that 
roof consistently. The width of an absorption (or Full Width Half Maximum, FWHM-prefix) is 
the length (in nm) of an imaginary perpendicular line across the center of the D line (Figure 2). 
The wavelength position (W-prefixed scalars) identifies the wavelength of the bottom of a given 
absorption feature. These W-scalars are frequently of use for vectoring to ore deposits as in many 
cases changes in the wavelength at minimum are the result of systematic changes in the 
substitution chemistry of a given mineral group, which may be a proxy for distance from source.  
For example, the three absorption feature wavelengths for alunite, white mica, and chlorite, 
shown in Figure 3 capture the changes of W1485, W2200, and W2250 as proxies for their 
composition, and show zonation with regards to porphyry copper deposit geometry in many 
cases. 

2. SWIR TECHNIQUES IN MINERAL EXPLORATION 
2.1 Section Introduction 
Short-wave infrared techniques are increasingly applied in mineral exploration, particularly for 
hydrothermal deposit types where alteration mineral zonation is well developed (Hauff, 2008), 
but difficult to visually recognize (e.g., abundant white, fine-grained mineral species). Alteration 
minerals in these scenarios commonly contain oxygen in water or hydroxyl bonds and as a result 
are SWIR-active (Duke, 1994), meaning easily identified through examination of their spectral 
response. Subtle variations in the chemistry of some of these minerals may be examined spatially 
through changes in the position of absorption feature wavelengths for a given species, which 
may be related to distance from source. Both potential vector types, alteration mineral 
distribution and mineral chemistry variation, can be difficult to identify visually (Crósta, 1990). 
A third vector type, undetectable to the human eye, involves calculations performed on multiple 
absorption features to proxy the degree of crystallinity of mineral families such as white micas or 
kaolinite. These values indicate the relative temperature of formation of the relevant mineral 
group, and when viewed spatially may provide a proxy for distance from source. An example of 
this, the ‘white mica crystallinity’ scalar, is shown in Figure 3.  

Deployment of portable SWIR acquisition hardware mitigates the wavelength limitations of the 
human eye, enabling rapid and cheap data acquisition to identify these zonation patterns in 
alteration assemblages and mineral chemistry variation. 

2.2 Vector Types  
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2.2.3 Alteration Mineral Distribution 

Zonation patterns of alteration minerals with respect to hydrothermal deposit types are generally 
well established. These patterns may be visible upon visual inspection but subtleties in alteration 
facies are often more difficult to differentiate, particularly in so-called “white rock” alteration 
zones such as the advanced argillic and phyllic (a.k.a. sericitic) zones of a porphyry copper 
system. In the case of the advanced argillic assemblage, the distribution of white, often fine-
grained clay or sulphate minerals such as kaolinite, alunite, dickite, diaspore, or pyrophyllite has 
distinct implications in terms of pH and temperature of formation and by proxy, relative distance 
to source. These minerals are difficult to differentiate visually but are easily identified using 
SWIR methods. In Figure 3 we can see the broad geometric relationships between porphyry 
copper alteration assemblages and their SWIR-active mineral assemblages.  

Examining SWIR mineral matches for systematically collected data on drill-cores in 3D may 
prove vital in identifying the placement and context of alteration assemblages and therefore 
provide indications of the location of mineralization, informing further drilling.   

 
Figure 3) From  (Trott et al., 2022), modified from (Corbett and Leach, 1998; Halley et al., 2015). Generalized porphyry 
copper alteration model (calc-alkalic Cu-Au "A-vein" type) showing distribution of alteration zones and their 
corresponding SWIR-active minerals. 

2.2.4 Mineral Chemistry Variation 

The substitution chemistry of some mineral types may be examined through its spectral response. 
Tschermak-type substitution where Al is replaced by (Fe, Mg) + Si in white mica minerals (i.e., 
illite, phengite, paragonite, muscovite) can be captured by examination of the wavelength at 
minimum (W2200) of the “AlOH” 2200 nm absorption feature (Duke, 1994; Halley et al., 2015; 
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Scott and Yang, 1997; Swayze et al., 1992). This substitution is controlled by factors like pH and 
concentrations of Fe2+ and K+ in the hydrothermal fluid (Halley et al., 2015) as it reacts with 
country rock and precipitates white mica minerals during the formation of phyllic or sericitic 
alteration assemblages in a porphyry system. More specifically, the value of W2200 shifts from 
2180 to 2225 nm as white micas increasingly substitute (Fe, Mg) + Si for Al, transitioning from 
paragonitic to phengitic composition.  

Another potential SWIR vector involves estimation of the Mg# for chlorite-dominated spectra, 
observed in the Fe:Mg ratio and seen in a wavelength shift of the “Fe/MgOH” absorption feature 
found around 2250 nm (W2250), and strongly coupled with a wavelength shift in the 
“Mg/FeOH” absorption feature around 2340 nm (W2340) (Neal et al., 2018; Scott et al., 1998). 
Higher 2250W values indicate higher Fe relative to Mg, and vice versa (Jones et al., 2005; 
Lampinen et al., 2017). In settings containing abundant hydrothermal alunite, the shift in an 
absorption feature around 1480 nm may be used to indicate the Na:K ratio, where higher/longer 
wavelengths indicate an increase in this proportion corresponding to a higher temperature of 
formation, and by proxy, nearness to source (Chang et al., 2011). 

The application of a given vectoring method is highly dependent on the scenario; white mica 
chemistry is likely to be very useful where widespread sericitic alteration is outcropping or has 
been drilled, chlorite mineral chemistry is likely to be useful in a propylitic-type environment, 
and alunite mineral chemistry may prove useful in the lithocap, or advanced argillic 
environment. Figure 4 illustrates the distinct environments where white mica vectors may be 
favored as opposed to alunite vectors. Figure 6, from Lampinen et al. (2017), also summaries 
some of the commonly used scalars mentioned herein. 

2.2.5 Crystallinity Vectors 

The crystallinity of white micas, as seen in Figure 3 and the center panel of Figure 4, can be 
estimated by division of the “AlOH” feature depth (D2200) by the depth of the water absorption 
feature found at 1900 nm (D1900) (Medina et al., 2021). Under higher temperatures of 
formation, white micas tend to crystallize with a more orderly structure and as a result 
incorporate less water in interlayered smectites, proxied by the relative depths (spectral 
abundances) captured by scalars for the D2200 white mica and D1900 water features.   
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Figure 4) From (Jansen and Trott, 2018). Some commonly used vectors for porphyry copper exploration using mineral 
chemistry (white mica composition W2200 and alunite composition W1485), and crystallinity (white mica crystallinity).



Field-portable SWIR acquisition, QA-QC, and processing guide 
  

 

9 
 

 
Figure 5) From (Lampinen et al., 2017). Descriptions of some scalars commonly used for vectoring. It should be noted 
that TSG base scripts using the profile method and 3- or 5-point polynomial fitting may generate artefacts. Instead, the 
“Pfit” method is suggested. 

3. QUALITY CONTROL AND QUALITY ASSESSMENT 
3.1 Section Introduction 
Consistent data collection with QA-QC controls is critical, especially for large projects with 
multiple users, over a long period, and potentially with multiple instruments. Wavelength 
differences of up to 5 nm for W1480 (alunite-related) and 2 nm for W2200 for the same samples 
analyzed using different instruments have been documented (Chang and Yang, 2012; Uribe-
Mogollon and Maher, 2020). Proper standardization allows for robust interpretation and 
facilitates application of machine learning techniques, which tend to require ‘apples-to-apples’ 
feature inputs. The need for guidelines and standards in this space has been highlighted 
previously (Kerr et al., 2011).  

Ideally, the analysis should be conducted in an environment with consistent lighting, however, 
good contact between the instrument and rock surface should minimize noise related to 
fluctuations in variable lighting conditions (Trott et al., unpublished). Analysis can be applied to 
uneven, flat, or rounded (e.g., drill core) rock surfaces. Rock chips (1 to 5 mm; e.g., reverse 
circulation chips) provide the best medium for sample representativity; fine pulps generate noisy 
spectra and should not be used. Spectra can be captured for residual soils, sieved to a standard 
size (e.g., -80 mesh), and may be particularly useful combined with soil geochemistry data. 
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A critical requirement is that the sample is dry, as H2O is spectrally active. Samples can be dried 
in a sunny area or in an oven at temperatures less than ~40° C, as higher temperatures could 
change the structure of some clays (e.g., convert smectite to illite) (Russell and Farmer, 1964).  

3.2 QA-QC Measures 
The first mandatory QAQC measure for SWIR spectrometers includes measuring a Spectralon™ 
white reference disc comprised of a fluoropolymer with nearly 100% reflectance in the SWIR 
range (Bruegge et al., 1993) If the various sensors in the instrument are functioning properly and 
the instrument is calibrated it will produce a flat line spectrum. The Spectralon™ disc can also 
act as a ‘blank’ to determine if there is any dust or debris in the analytical probe. Most 
instruments are shipped with at least one Spectralon™ white reference disc. Care must be taken 
to keep them clean and not touch the upper surface, as skin oils can contaminate the spectral 
response. Contaminated discs can be recovered by wet sanding the surface with fine carbide 
sandpaper and allowing it to dry overnight. 

A second mandatory QAQC measure is the analysis of a Mylar ‘standard’, which has five 
pronounced absorptions (1128.7, 1660.1, 1952.9, 2131.6, and 2256.0 nm) allowing the user to 
determine the accuracy of their instrument and whether it is within calibration limitations (i.e., 
within ± 1 nm of the known absorption feature wavelength). The ideal method for analyzing the 
Mylar standard is by placing it on top of the Spectralon™ disc. 

We also recommend usage of an in-house standard consisting of a mineral with a relatively 
homogeneous composition, which occurs in the study area; ideal candidates might be white mica 
(illite, paragonite, muscovite, phengite), kandite (halloysite, kaolinite, nacrite, dickite), alunite, 
and/or a chlorite-rich sample. The Mylar and in-house standards allow the user to track accuracy 
and variation in key absorptions features (e.g., W2200, W1480, etc.) over time and between 
instruments, allowing results to be leveled, if necessary.  

Analytical duplicates (duplication of an analysis spot) are also recommended to ascertain the 
precision of results.  

All four of these QAQC measures should be used at the beginning and end of the analysis 
session and periodically (intervals of ~ 20 measurements) throughout the session.  

3.3 QAQC Evaluation 
Two basic plots can be used to assess quality of collected data. A first pass assessment of 
spectral quality may be carried out using a plot of Signal to Noise against Error (Figure 7.A). It 
must be kept in mind that rocks containing minimal amounts of SWIR-active minerals may also 
plot in the “Poor quality” field. For this reason, some caution must be applied during the 
evaluation process, and it may not be advisable to reject a spectrum based on this plot alone. A 
bound water vs unbound water plot, as shown in Figure 7.B, can indicate if wet samples may 
have negatively impacted the quality of spectra acquired. 
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Figure 6) Quality assessment based on Signal to Noise ratio versus Error (A), and assessment of water interference based 
on the amount of unbound water relative to bound water (B). Plots generated in ioGAS. 

To create a similar pair of plots in TSG8, navigate to the “Scatter” view and customize the X and 
Y fields found at the base of the upper toolbar (Figure 7). 

 
Figure 7) Plots for evaluation of spectral quality and wet samples (SNR = Signal to Noise Ratio). Plots generated in TSG. 

Assessment for instrument drift or acquisition problems can be carried out after collection is 
complete and the “Mylar_QAQC_scalars.tsg” template file has been applied to the data. Return 
to this after proceeding through Sections 4 and 5. The fundamentals of preparing the Mylar QA-
QC data are basically the same, except the mylar tsg template is applied instead of the SWIR 
template, and the exported scalars can be filtered down to the readings taken on Mylar. 

The “Mylar_QAQC_scalars.tsg” template will extract the wavelength position of the four 
prominent Mylar absorptions, 1660.1, 1952.9, 2131.6, and 2256.0 nm, respectively. Four 
additional scalars, prefixed with “Diff” are used to calculate the difference between the ideal 
position and the measured position. These four scalars should be plotted and examined for 
differences of greater than 1 nm (positive or negative). The example shown in Figure 8 is drawn 
from Mylar readings taken using the same instrument on the same sheet of Mylar throughout an 
acquisition session, and show very consistent results, mainly within tolerance (± 1 nm of the 
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idealized absorption). Results plotting outside of this tolerance range require follow-up to assess 
if the measurements taken during those sessions are valid, require correction, or must be 
discarded. 

 
Figure 8) Mylar QA-QC assessment visualized in sequence of acquisition through an analytical session. From (Jansen, 
2016). 

4. ACQUISITION 
4.1 Section Introduction 
Since the introduction of the PIMA by Integrated Spectronics (Thompson et al., 1999), numerous 
manufacturers have developed a wide range of field-portable instruments with varying 
characteristics and distinct acquisition software to accompany them. This information should be 
laid out in the user’s guide accompanying the make and model in use. Manufacturer’s 
instructions should be followed carefully during acquisition.  
QA-QC measures, as described above, should be inserted in the sample stream, and metadata, as 
described below, should be carefully recorded at the time of capture, and saved into a stable, 
accessible database for future use. 
 
4.2 Metadata Capture 
Regardless of manufacturer and instrument specifics, some critical information must be recorded 
at the time of acquisition, for two important purposes: 1) to facilitate QAQC evaluation, and 2) to 
relate results to their geographic location. 

Key metadata that should be recorded at the time of collection are Spectral ID, user, date, 
instrument model, instrument serial number, analysis time, location (depth and drillhole ID for 
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subsurface data, or X (easting/longitude) and Y (northing/latitude) coordinates and 
corresponding datum for surface data), and sample medium (e.g., rock, drill core, rock chips, 
QAQC/type etc.). If readings are being taken on coarse laboratory rejects then the corresponding 
sample ID should be recorded, so that the results can be easily merged with any corresponding 
geochemistry later. The above information should be recorded digitally and warehoused in a 
database where it can be extracted, merged with results, and used to evaluate QAQC and locate 
the results geographically (i.e., import into a GIS platform or 3D visualization software). 

An example of a basic metadata capture sheet implemented in Microsoft® Excel can be found in 
Appendix A. Cell validation for some data types (i.e., date and time formats, pick lists, etc.) has 
been applied as per the Format column in Table 2. 

 

 
Table 2) Some suggested metadata fields. For a simple example of a metadata spreadsheet with cell validation included 
see Appendix A: “AppendixA_Spectral_Metadata.xlsx”. 

Column Header Format Examples

SpectralID *text PROJNAME_000001.asd

Sample_Type *pick-list
Drill-core, Hand Sample, Outcrop, Coarse 

Reject, Soil, Sieved, RC Chips

QAQC_Type *pick-list
SAMPLE, DUPLICATE, MYLAR, STD-1, STD-2, 

SPECTRALON

SampleID *text LABSAMPLE_01987

HoleID *cell DDH_2022-01

Depth_m *numeric 230.5

From_m *numeric 230

To_m *numeric 232

Easting *numeric

Northing *numeric

CRS_datum *pick-list WGS84_N16, WGS84_N15, etc.

Instrument *pick-list

Halo (SERIAL#), OreXplorer (SERIAL#), PIMA 

(SERIAL#), Hi-Res 4 (SERIAL#), NA (historic 

data)

Acquisition_Date *YYYY-MM-DD 2023-08-22

Acquisition_Time *HH_MM_SS 14:23:00

Acquisition_Location *pick-list
Core Shed "A", Core Shed "B", In Field (see 

coordinates), in Laboratory "A"

Sample_Type *pick-list

Vein, Vein Halo/ Aureole, Wallrock, Breccia 

Fragment, Breccia Matrix, Random/ 

Systematic, Contact Alteration Aureole, 

Fracture Surface

User *pick-list Jane Doe, John Doe

Comments *text
Rubbly interval, difficult to find flat 

surface.

In case questions arise as to collection methods.

Any additional information, as needed.

coordinate reference system or datum used for 

Easting/Northings. (field or hand sample)

Instrument make/model and serial number. To consider 

differences between machines if multiple machines used.

On windows computer CTRL-; (semi-colon)

On windows computer, CTRL-SHIFT-; (semi-colon)

In case environmental parameters have an impact on spectral 

response (I.E. humidity in an outdoor setting)

Geological context of where the measurement was taken, or if 

acquisition was simply carried out systematically (ie by 

geotechnicians).

If taken on Drill-core

If taken on drill-core

If taken on coarse rejects from drillcore (corresponding 

interval).

If taken on coarse rejects from drillcore (corresponding 

interval).

If taken in the field or from a hand sample brought back from 

this location.

If taken in the field or from a hand sample brought back from 

this location.

Description

Critical field for relating results from TSG, or raw spectra,  to 

the correct metadata.

A.K.A. Sample medium

Regular sample or some form of QAQC sample?

Use this if reading taken on a coarse reject or soil sample 

which will also ultimately have geochemical results.
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5. PROCESSING 
5.1 Section Introduction 
Historically users needed to specialize extensively in a very manual process of identifying 
mineral species from individual spectra, a time-consuming endeavor with the quality of results 
highly dependent on the expertise of the user. A very apt commercial solution to this, aiSIRIS, 
consists of a cloud-based, largely automated software wherein uploaded spectra are classified 
relative to a large library of expert-interpreted spectra. Presented results emphasize estimated 
minerals and scalars, not their input spectra. For users who wish to interpret spectra themselves, 
in a more involved way, The Spectral Geologist (TSG) software enables bulk processing of large 
volumes of spectra through its implementation of (i) ‘The Spectral Assistant’ to unmix spectra 
against a pure mineral reference library for mineral identification and (ii) extraction of ‘scalars’ 
to quantify the geometry (shapes) of key absorption features (Berman et al., 1999; Huntington et 
al., 1999). TSG is apt for bulk processing tasks but still requires a certain level of prior 
knowledge to operate effectively and reduce the resulting data into useful vectors. For companies 
with a great deal of throughput and perhaps multiple sites, aiSIRIS is likely the best alternative, 
for consistency in processing and comparability (provided that adequate QA-QC measures are 
implemented during capture). For smaller companies wishing to develop in-house knowledge, 
academics who desire more control over the processing of their data, or aiSIRIS users wishing to 
perform their own QA-QC, TSG is a good option. This manual focuses on the second scenario 
and is intended to guide a novice or experienced user equally through a robust workflow to 
process spectral datasets. For further information not included in the following workflow, the 
TSG Manual itself is available in the Help menu within the software (or online, here: 
https://research.csiro.au/thespectralgeologist/support/downloads/). 
This paper is not intended as a replacement for the TSG manual, rather to provide walkthrough-
style guidance geared specifically toward processing and cleaning spectral data for mineral 
exploration. 
 
5.2 The Spectral Geologist 
TSG is a software created by Commonwealth Science and Industrial Research Organization 
(CSIRO), Australia, for unmixing and extracting information from VNIR, SWIR, and thermal 
infrared (TIR) spectra. It uses an algorithm called ‘The Spectral Assistant’ (TSA) as default to 
identify minerals and relative spectral abundances (Huntington et al., 1999; Schodlok et al., 
2016). It compares new spectral data against a curated internal spectral library developed and 
maintained by CSIRO (Smith, 2016), unmixing acquired spectra to their closest equivalents or 
mixed assemblages in the library. TSG allows for bulk processing of hundreds or even tens of 
thousands of spectra in a highly repeatable manner, which can be carried out in minutes, not 
days. 
A caveat here is that the current TSA version (V8) will unmix up to four most predominant 
mineral signatures per spectrum at most. An experienced interpreter would most likely be able to 
manually extract more minerals from the same spectra but at a much higher time cost. 
TSG may be downloaded at https://research.csiro.au/thespectralgeologist/tsg/pricing/, and 
licensed for blocks of time ranging from 7 days for $110 AUD to 3 years for $4950 AUD 
(current as of time of this publication).  
Installing TSG without an active license will enable it to act as a free (read-only) base version for 
viewing previously processed results. For users with background in the python programming 

https://research.csiro.au/thespectralgeologist/support/downloads/
https://research.csiro.au/thespectralgeologist/tsg/pricing/
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language (Van Rossum and Drake Jr, 1995), existing .tsg files can be read and viewed using the 
“pytsg” library (Chi, 2022) found at https://github.com/FractalGeoAnalytics/pytsg. 

5.2.1 Customizing an active minerals list 

TSA is a general-purpose unmixing algorithm that, initially, does now know where in the world 
your spectra come from or the source or style of geological environment. Its first pass then is 
called a “system” level interpretation of the minerals. The user may then choose to apply some 
context to the project being addressed (e.g., is it porphyry, epithermal, advanced argillic, 
orogenic gold, base metal or sedimentary). Armed with this understanding the user may create an 
“Active Minerals List”, or AML, that informs a second TSA iteration leaving out those minerals 
that are thought to be irrelevant to the expected model, but still allowing some room for 
serendipity. The “Active Mineral Classes” menu shown in Figure 9 may be accessed via “File-
>Settings->TSA->Select active minerals”. This second TSA iteration (much faster to process 
than the first iteration) produces a more reliable “User” level interpretation. Both “System” and 
“User” results should be archived in case a further iteration is required, but for most applications 
the “System” level interpretation is merely an important part of the recommended workflow to 
arrive at optimal results and can be set aside.  
 

 
Figure 9) Example of an Active Minerals List (AML) for a dataset with some minerals turned off (improbable minerals 
for this specific geological setting). 

TSG also provides tools for within drill hole Domaining where a further level of mineral filtering 
can be applied via a “Restricted Mineral Set” (RMS) that can be used to assign minerals to 
selected spectro-mineralogical intervals, or perhaps, lithologies or alteration zones. 
 

https://github.com/FractalGeoAnalytics/pytsg
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5.3 Processing in TSG (SWIR) 

5.3.1 Importing Spectra 

Start by importing your spectra. From the “File” menu select “New”. In the dialog box that 
appears choose the appropriate file format. In this walkthrough we are using .asd files acquired 
with a Terraspec Explorer™. 

 
Figure 10) TSG opening screen (top), and list of importable file formats available from "File->New” (bottom). 

Next, in the “Select binary ASD files (field spectra)” dialog box, browse to your spectra and 
select them or select a directory containing your spectra (holding down the shift button also 
works to select multiple spectral files). Use the settings shown in Figure 11. Note that the “Parse 
filenames” option may be useful if metadata like drillhole ID or meterage is embedded in the 
filenames of your spectra. Click “Next”. 
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Figure 11) Setting for the import of .asd files. 

In the “Wavelength info and resampling” dialog box, set the “Output wvl. Min” value to 1300 
(nm) and the Max value to 2500 (nm), as shown in Figure 12. This restricts the smoothing 
operations and region to be interpreted by TSA to SWIR. Click “Next”. 
 

 
Figure 12) Further settings for the import of spectral files. Note that the output wavelength minimum has been set to 1300 
nm (bypassing the VNIR range). 

In the “Additional info” dialog box, shown in Figure 13, select “Spectralon absolute reflectance 
(generic)” as the final correction spectrum, provided that the white reference used during capture 
was indeed Spectralon™ (generally the case). Click “Finish”. At this point the software will 
import your spectra, prepare them according to the previously described settings, and TSA will 
produce mineral matches.  
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Figure 13) Final step of the import process. Definition of a save location for the .tsg file to be generated and setting the 
correction spectrum to Spectralon. 

Notice that even very large datasets are processed almost instantly. This is the benefit provided 
by TSG in comparison to manual interpretation. An experienced interpreter might be able to 
identify more minerals but would take exponentially longer to do so and may struggle to 
maintain consistency. For large, systematically collected datasets, the speed and consistency 
benefits of TSG far outweigh the costs. 

5.3.2 Navigating TSG 

In the top right-hand corner of the software, you’ll find buttons labelled “Summary”, “Log”, 
“Spectrum”, “Stack”, and “Scatter”. These will direct you to views into distinct functions. 
The “Summary” view (Figure 14) shows summary scatterplots for a broad overview of the 
classified dataset. 
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Figure 14) Summary view of the imported dataset. The first view to appear after successfully importing new data. 

 
The default “Log” view (Figure 15) will show the sample number, colored versions of the 
normalized spectra, up to three minerals identified by TSA (columns prefixed with Min1, Min2, 
Min3), and an error bar, representing how well the spectra matches to the identified minerals. 
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Figure 15) The 'Log' view, showing TSA mineral matches and a measure of error, alongside a top-down representation of 
the spectra. 

The “Log” view can give a first impression about the quality of the dataset. The column labelled 
“Norm. HullQ” contains a colored, top-down view version of the Hull normalized (smoothed) 
spectrum for each sample, where blue indicates high reflectance and red indicates absorption, as 
illustrated in Figure 16. 
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Figure 16) Illustration of how a spectra is represented as a colored band in the software, where the depth of absorptions 
corresponds to hotter colors. 

 
Figure 17 shows good quality spectra (left), with little noise, where absorption features are crisp 
and clearly defined. Spectral quality is much poorer in many cases on the right, where the bars 
look noisy and/or striped. This may be due to a lack of white referencing, leading to sensors 
drifting over time and creating offsets in the intensity results.  
Other sources of poor-quality spectra may include: 

• Wet or dirty samples at the time of acquisition, 
• Poor contact between the probe and the sample, permitting entrance of ambient light, 
• Loose or partially broken fiber optic cable between the probe and processing unit. 
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•  
• Figure 17) Comparison of some generally good data (left) and some poorer quality data (right). 

 
It is important to realize that not every mineral is active in the SWIR range. This is particularly 
true for minerals without bound water, ammonium, or OH- bonds. In other words, anhydrous 
minerals are unlikely to be detectable. 
For instance, spectra may come back “aspectral” if taken on rocks with: 

• Abundant plagioclase 
• Massive SiO2 
• Dark colours and low reflectance as a result. 

In other words, “Aspectral” readings do not necessarily indicate poor quality spectra; they may 
be telling you something about the mineralogy of that sample (more specifically, that OH- bonds 
aren’t present in the minerals under the probe, Figure 18). This might be important information 
in a scenario where one of the alteration facies consists of widespread, pervasive silicification, 
for example. 
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Figure 18) “Aspectral” readings in the above dataset are not all poor quality data. Some of these represent samples taken 
over areas of the rock that do not contain SWIR-active minerals. 

 
In the “Spectrum” view, spectra from your dataset may be visually compared to spectra from the 
inbuilt TSG library. This may prove useful in cases where TSA results are ambiguous. With the 
“SWIR TSA” radio button activated (Figure 19) two lists will appear on the lefthand side of the 
view, where a spectrum from the imported data may be selected (“Sample”) in addition to a 
reference spectrum (“Reflib”).  
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Figure 19) “Spectrum” view with the “SWIR TSA” radio button selected. A measured spectrum (green to yellow trace) is 
being compared to a reference spectrum for paragonite (pink trace) in this example. 

Activating the “2nd” radio button will allow comparison between two collected spectra, as shown 
in Figure 20. 
 

 
Figure 20) “Spectrum” view with the “2nd” radio button selected. Two measured spectra are being compared in this 
example. 
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5.3.3 Extracting Scalars using a Template 

TSG enables application of scalars using a template, where the scalar methods used in an 
existing .tsg file can be applied to a recently imported dataset. This is a time-saver and ensures 
that calculations are being carried out consistently between datasets. 
From the “File” menu hover over the “Copy processing” menu and select “Scalars and layout” 
from the submenu that appears. Select the template (existing .tsg file) from which you’d like to 
copy the scalars and order and they will be applied to the newly loaded dataset. The provided 
template, “SWIR_scalars.tsg” contains a variety of useful scalars, described in Table 3. Note that 
a .tsg file needs to be accompanied by the corresponding .bip and .ini files. 
 

 
Table 3) Brief descriptions of the scalars displayed in the SWIR_scalars.tsg template. 
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Figure 21) Perhaps the most useful functionality of TSG, scalar calculations and layout can be replicated from an existing 
.tsg file, by selecting the file via “File->Copy Processing->Scalars and layout”. 

5.3.4 Creating and Adding Custom Scalars 

If you’d like to create a new scalar, click “new scalar” from the “Edit” menu. 
The “Construct/Import Scalar” window will appear. We will examine the construction of a 
simple “PROFILE” scalar. Select this from the “Method” dropdown menu and hit “Next” 
(Figure 22). 

 
Figure 22) The first step in creating a custom scalar. “Slot” and “Group” pertain to where the scalar will be stored. 
“Method” indicates the type of scalar to be created, in this example “PROFILE” refers to a measurement of geometry 
taken directly from the spectra. 

The settings shown in Figure 23 will produce a W2200 scalar, where the position (in nm) of the 
wavelength minimum found 10 nm to either side of 2200 nm will be the output. 



Field-portable SWIR acquisition, QA-QC, and processing guide 
  

 

27 
 

Choosing “Relative absorption width” will produce the D2200 scalar (absorption depth), or 
“Absorption or peak FWHM” will produce the FWHM2200 scalar. 
Other “Method” settings enable different styles of scalars. For instance, an “ARITHMETIC” 
scalar is a calculation performed on other scalars, like division of D2200 by D1900 to produce a 
white mica crystallinity output. 
 

 
Figure 23) Example of the setup for a W2200 scalar, and how the same setup could be modified for D2200 or 
FWHM2200. With these settings geometry is measured from a region of the spectra centred at 2200 nm and extending 10 
nm to either side (2190 – 2210 nm range). 

Newly created scalars can be added to the “Log” view as desired. To visualize a scalar, right 
click any scalar, and select “Insert column” from the “Edit / Add / Del” submenu. If 32 scalars 
are already present in the view it will be grayed out and you will need to replace a scalar that is 
currently visualized (Figure 24).  
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Figure 24) Menu path to insert a new scalar column. In this example 32 scalars are already displayed so the option is 
grayed out. In this case a scalar would need to be deleted to enable this option or an existing scalar plot modified using the 
“Item to plot” option. 

If you successfully inserted a new column, a copy of the last scalar will appear at the far right-
hand side of the “Log” view. Right click this new column (or another column that you would like 
to replace) and click “Item to plot…” (Figure 25). 
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Figure 25) “Item to plot...” allows the user to select which scalar to visualize in the selected column. 

In the subsequent menu, “Item for Log Column” (Figure 26), you’ll be able to select from inbuilt 
TSA scalars (“System SWIR”) or choose a custom scalar (“General”). The selected column will 
be replaced with the chosen scalar. 
 

 
Figure 26) Preconfigured scalars may be found in 'TSA->System SWIR' or custom scalars might be stored under 
'General'. 

Saving the active .tsg file after adding new scalars means that they will be automatically 
calculated for future datasets when the current .tsg file is applied as a template through “Copy 
processing” as described above. 
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At this point the “Log” view should be crowded with scalars copied from the template and any 
new scalars you may have added (Figure 27). The current version of TSG allows 32 scalars to be 
visualized on the Log page. 
 

 
Figure 27) A full set of scalars visualized. This screen is difficult to parse visually but does indicate which columns will be 
included in the subsequent csv export. 

5.3.5 Exporting from TSG 

At this point it is advisable to export the raw spectra as a table of spectra (rows) vs reflectance 
per band (columns). Storage of raw data is an important and often overlooked step prior to 
spectral processing. Individual spectral files (e.g., *.asd, *.sed, *.ascii) can be saved along with 
their corresponding metadata. However, the most ideal format is as tabular spectra that can 
imported into a relational database linked with the spectral interpretation and any other 
geoscientific data (e.g., geochemistry). Preserving raw spectra permits consistent interpretation 
when new data is added to a project or future reprocessing using new advancements. 
An interesting quirk of TSG is that export options in the File menu are dependent on the current 
view. To export raw data in a tabular format, navigate to the “Stack” view, and then select 
“Export to CSV (spectra)” from the File menu (Figure 28). This will export a .csv file of the 
dataset where reflectance is assigned to bands (columns) for each sample (row). This is a format 
that lends itself to import into a relational database, and where the sample ID can be used to link 
the spectra to its metadata or additional accompanying data. 
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Figure 28) Export of raw spectral data in tabular format must be done from the “Stack” view, following “File->Export-
>to Csv (spectra)...”. 

Save the exported spectra into a relational database, along with the metadata captured with it. 
When you add new data from your project, or add a new and exciting scalar, you can import it 
back into TSG and process it again, by choosing the “General: ASCII table (one big CSV file full 
of spectra)” format in the “Create a new dataset” dialog box. 
Once the raw data is exported and saved for future use, switch the view over to “Log”. You’ll 
notice that in the File->Export submenu “to Csv (spectra)” is now grayed out but “to Csv 
(scalars) is now available (Figure 29). Click this to export your scalar output as a .csv file. 
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Figure 29) Notice that “to Csv (spectra)...” is grayed out from the “Log” view. Scalars can now be exported, following 
“File->Export->to Csv (scalars)...”. 

5.3.6 Cleanup of Scalar Table 

Open the newly exported .csv file (the scalars). You’ll see a row per sample/measurement and 
numerous columns corresponding to mineral matches, error, and extracted scalars. You will 
likely see some cells with “NULL” rather than a number; in most cases these are scalars where a 
given sample did not contain that absorption feature. The Error column may also have some null 
values, where the error calculation failed. The error is on a scale from 0 to 1000, where 0 
represents a perfect spectral match to the reference library (rare), and higher values represent 
increasingly dubious matches. For subsequent steps you’ll need a purely numeric column to plot 
mineral matches against. For this reason, highlight the Error column and use Excel’s “Find and 
Replace” function to replace “NULL” with “1000”. 
Once this is finished, highlight the entire sheet and replace all other nulls with an empty cell 
(Figure 30). 
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Figure 30) MS Excel's “Find and Replace” function (“Home” tab) may be used to replace NULLs in the error column 
with 1000 and remove all other nulls by leaving “Replace with:” empty. 

Save and close the .csv file; it is now formatted such that it can be easily read by ioGAS or 
similar software. 
 
The following steps are described using ioGAS software. The procedure itself can likely be 
carried out in a variety of software; for convenience we illustrate with ioGAS, as it contains 
several functions/tools which make the process straightforward. Most useful are the “point 
density opacity” function and “attribute polygon” tool, found on the vertical toolbar on the right-
hand side of the ioGAS interface. 
 

5.3.7 Import to ioGAS 

After opening ioGAS, select “New” from the “File” menu. Set “Files of type” to “All Files” or 
“csv” and browse to the scalar table exported in the previous step (Figure 31). Open it. 
 

 
Figure 31) Importing a .csv file into ioGAS. 
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If an error about unequal row lengths (Figure 32) appears there is a problem in the way 
delimiters are being parsed. In this situation, cancel the import, save a version of the .csv file as a 
.xlsx, and open it into ioGAS in that format. 
 

 
Figure 32) If this warning appears while importing a .csv file, convert the file to .xlsx format and import it again. 

When the “Column Properties” dialog appears, look at the “Alias” and “Type” columns (Figure 
33). Most of the columns should be of type “Numeric” (blue circles). The mineral match (Min1, 
Min2, Min3) columns should be of type “Text” (black circles). If the NULLs were improperly 
removed in the previous step, some columns for scalar values which should be numeric may 
attempt to default to text. If this is the case open the .csv and find/replace NULLs carefully, as 
described previously. SpectralID and Date will most likely default to “Text” type, which is fine. 

• At no point during this process should you ever click the “Guess Aliases” button. This is 
an ioGAS function, extremely useful for geochemical data, which will attempt to 
recognize geochemical data columns appropriately. In the case of SWIR scalar outputs, it 
will just make a mess attempting to match scalar names to elements from the periodic 
table. 
 

 
Figure 33) Provided all the NULL replacements were carried out successfully, no modifications should be needed in the 
“Column Properties” dialog. NEVER select “Guess Aliases”. 

Click ‘OK’ to finish importing your data into ioGAS. 
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5.3.8 Mineral Groupings 

TSG mineral matches are algorithmically driven and anchored to a reference library; nature 
abhors absolutes and as a result many mineral matches may be too specific and unrealistic. 
Manually generalizing some results into mineral groups is the most reliable way to arrive at 
accurate results that do not over-interpret the mineralogy. White mica minerals are a prime 
example of this; TSG will match a spectra containing white mica to any of: paragonite, illitic 
paragonite, muscovite, illitic muscovite, illitic phengite, and phengite, as these are the white mica 
minerals found in its spectral library (Figure 34).  
 

 
Figure 34) Some of the white mica and kaolinite variants matched by TSA. While the white mica variants are almost 
certainly white micas, compositional distinctions are better determined through examination of the W2200 value. 

While there are undoubtedly different species of white mica in many datasets, TSG doesn’t 
necessarily separate them robustly. For this reason, it is important to group these highly specific 
mineral matches into a more general “White Mica” class. In the case of white mica minerals, 
speciation can be more systematically evaluated using the W2200 value. The same logic applies 
to kaolinite (Kaolinite-WX and Kaolinite-PX may be grouped) and several other mineral classes 
(carbonates and amphiboles most notably). See Table 4 for suggested groupings. The grouping 
scheme is geared toward the porphyry/epithermal environment; distinct groupings and/or 
nomenclature may be useful in other environments. The white mica – kaolinite and white mica – 
chlorite mixtures, however, should be determined this way regardless of environment, for 
reasons detailed in “Dealing with Mixtures”. 
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Table 4) Suggesting groupings based on TSA-suggested mineral matches. 

To generate these groupings in ioGAS, open the “Select Variables” dialog, and move the Error 
and Min columns to the right using the white arrow (into the “Selected” list, as shown in Figure 
35). Make sure that the Error column is first in the list as it will become the common axis for 
three XY plots. Hit “OK”. 
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Figure 35) Selection of variables to create plots of TSA mineral matches against error. 

In the upper toolbar, click the “XY Plot” icon to generate three plots of the Error against the 
three mineral matches. We replaced NULL with 1000 earlier; a numeric axis was required for 
these plots. 
 

 
Figure 36) These plots facilitate manual regrouping of identified minerals. 

At this point, open the “Attribute Manager” and set up color categories for your mineral 
groupings (Figure 37). 
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Figure 37) Example of partially regrouped mineral matches. 

The .gat file accompanying this document, “Mineralogy_SWIR.gat”, can be used by accessing it 
through the “Load Attributes” button, or you can generate your own groupings as desired. For 
consistency we suggest using the supplied legend in the .gat file. This will import predefined 
categories with assigned colors, although readings will still need to be populated appropriately, 
using Table 4 as reference. Highlight each mineral group in the legend one at a time, and while 
the correct group is highlighted, use the “Polygon Select” tool from the righthand toolbar to draw 
polygons around the appropriate minerals in the Min1 plot (just Min1 for now, or the strongest 
match per sample), thereby attributing them into the highlighted color group (Figure 37).  

5.3.9 Dealing with Mixtures 

Some mineral mixtures can complicate scalars used for vectoring to ore deposits.  
Tschermak substitution in white micas, as quantified in the position of the 2200nm absorption 
feature (W2200), can be a useful vector towards hydrothermal ore deposits like porphyry copper 
or epithermal gold. Unfortunately, kaolinite also has an absorption at 2200nm and a much higher 
albedo than white mica, so in a spectrum containing both, the absorption feature will always 
show the position of the absorption as it relates to kaolinite, NOT the white mica.  The kaolinite 
absorption is ALWAYS around 2207-2208 nm (it does not show systematic compositional 
variation like the white micas). 
Meaning that this sort of vectoring is impossible in spectra containing any amount of kaolinite in 
addition to white mica, and hence the importance of resolving which spectra are mixtures vs pure 
white mica. 
To resolve this better, we will create a mixed color category where samples with a white mica in 
Min1 and kaolinite in Min2 or Min3 can be placed; along with samples showing kaolinite in 
Min1 and a white mica in Min2 or Min3. Make all the color categories except “White_Mica” 
invisible (“All Invisible” button in the Attribute Manager). Use the “polygon select” tool to 
attribute the points showing “Kaolinite-WX” or “Kaolinite-PX” in the Min2 and Min3 XY plots 
into the “White_Mica_Kaolinite_Mixture” color category. When you’ve finished with that, turn 
everything invisible again and then make “Kaolinite” visible. Now use “polygon select” to 
attribute points showing any white mica species in the Min2 and Min3 plots into the mixture 
color category. 
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Repeat the above process to create mixture categories for white mica and chlorite mixtures. This 
combination may impact vectoring using W2250 or D2250 and should be identified for later 
filtering. 
 
Returning to the white mica – kaolinite mixtures, we can further resolve this using the 2200 nm 
absorption feature. In the “Select Variables” dialog, move W2200 and FWHM2200 into the 
righthand box. Create an XY plot with W2200 on the x-axis and FWHM2200 on the y-axis. In 
the “Attribute Manager” make all color categories invisible except for White_mica, Kaolinite, 
and White_Mica_Kaolinite_Mixture. Notice the way kaolinite and mixtures group themselves in 
the 2207-2208 position, often at lower FWHM2200 values (Figure 38). 
 

 
Figure 38) Samples identified in the 'White_Mica' group that are located in and around the 'Kaolinite' and 
'White_mica_kaolinite_mixtures' groups in the vicinity of 2206-2209 nm may contain some influence from kaolinite and 
should not be used for vectoring using aspects of the 2200 nm absorption geometry. 

Another useful way of visualizing these populations is by experimenting with the “Point density 
opacity” button on the righthand toolbar (Figure 39). Notice the left to right trend of 
predominantly white mica spectra and compare it to the subvertical kaolinite trend forming a 
triangle downward toward 2208 nm on the x-axis.  



Field-portable SWIR acquisition, QA-QC, and processing guide 
  

 

40 
 

 
Figure 39) Point density visualization of the white mica and kaolinite subset. Note the pronounced kaolinite feature 
centered around 2208 nm. 

Now that you’ve recognized where these spectra most likely contain an influence from kaolinite, 
make the Kaolinite category invisible and use the locations of the 
White_Mica_Kaolinite_Mixture spectra to re-attribute White_Mica spectra into this category 
with the “Polygon select” tool. Make the Kaolinite visible again. The spectra that are still in the 
White_Mica category can be used reliably now to vector with W2200 (white mica composition), 
as shown in Figure 40. 
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Figure 40) Illustration of how spectra with a possible influence from kaolinite might be regrouped as mixtures (and 
thereby disregarded for W2200 vectoring). 

Once you’ve followed the above steps and are satisfied that you’ve: 
• simplified any mineral species that were over-interpreted by TSG, and 
• grouped and identified mineral mixtures that may impact your work, 

make all the mineral groupings visible in the “Attribute Manager” and from the Data submenu of 
the horizontal toolbar at the top of the screen, inside the “Make Variables” section, choose 
“From Colour”. 
This will add your color groupings to the underlying data table as an additional column. 
Name the new column “Mineralogy_SWIR” (Figure 41). 
 

 
Figure 41) Saving the newly assigned groupings into the underlying data table. 

 



Field-portable SWIR acquisition, QA-QC, and processing guide 
  

 

42 
 

 

5.3.10 Export and Cleanup 

At this point the data table can be exported as a .csv file using the “All: export all rows” button 
in the “File” menu (Figure 42).  
 

 
Figure 42) Export the regrouped data. 

After opening the exported .csv file, you’ll notice that two columns have been added at the far 
right of the columns originally exported from TSG, “Mineralogy_SWIR”, containing numbers, 
and “Mineralogy_SWIR Text” containing the groupings created earlier (as text, shown in Figure 
43). The “Mineralogy_SWIR” column can be deleted; it is simply a numeric version of the 
mineral groupings. After deleting this column, rename “Mineralogy_SWIR Text” to 
“Mineralogy_SWIR”. These groupings will be used to filter columns to valid vectors.  
 

 
Figure 43) Two new columns added to the exported data. The numeric column can be deleted, and the word 'Text' 
removed from the heading of the text column. 

Find the “W2200”, “D2200”, and “White_mica_crystallinity” columns. Copy/paste them at the 
righthand side of the “Mineralogy_SWIR” column.  
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Highlight all your data by clicking the top left corner of the excel sheet and then from the File 
menu choose “Filter” below “Sort & Filter” (Figure 44). 

 
Figure 44) MS Excel's 'Filter' functionality. 

Using the filter dropdown that appears in the “Mineralogy_SWIR” column header, deselect 
“White_Mica” (Figure 45). 

 
Figure 45) Example of (temporarily) filtering out pure white mica spectra so that the W2200 vectoring scalars can be 
cleared of values for samples that are NOT purely white mica. 
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Select all the remaining entries in the three columns that were copy/pasted and erase their 
contents (right-click and “Clear Contents”). Use the Mineralogy_SWIR filter and turn the white 
micas back on. These three columns can now be used for vectoring using white mica chemistry. 
Rename “W2200” to “White_Mica_Composition”, “D2200” to “White_Mica_Abundance”, and 
“White_Mica_Crystallinity” to “White_Mica_Crystallinity_filtered”.  
Repeat this process for the W2250 and D2250 columns, except deselecting “Chlorite”, and 
renaming “W2250” to “Chlorite_Composition” and “D2250” to “Chlorite_Abundance”. These 
may also provide useful vectors in a dataset with abundant chlorite spectra. These four new 
columns (Figure 46) have been filtered to only the relevant values (pure spectra) and are now 
valid columns for vectoring. 
 

 
Figure 46) Examples of vectoring columns filtered in accordance to the purity of the mineral match for white mica and 
chlorite, respectively. 

In a dataset with abundant alunite, the same composition and abundance columns can be created 
for the W1485 (Alunite_composition) and D1485 (Alunite_abundance) scalars, but this time 
deselecting alunite species when they appear in any of Min1, Min2, and Min3. 
Once these changes are made, save these results to the same database where the metadata is 
located, and export the results combined with their spatial information (e.g., coordinates or 
drillhole collars and depths) and any other data that might be desirable (e.g., corresponding 
geochemistry results, geological description of samples, etc.). Load this information into a 2D 
GIS platform (for surface datasets) or 3D platform (for drillhole datasets) and start looking for 
gradients toward your next discovery! 

6. CONCLUSIONS 
It is hoped that this walkthrough can aid new users and provide some guidance to experienced 
users. Aside from the mechanics of working through a dataset, particular attention should be 
placed on QA-QC considerations, metadata capture, and storage of all products, including 
metadata, raw spectra in tabular format, and scalar outputs. A far-flung goal of this publication is 
to enable captured data to be accessed, corrected, and utilized by future workers, fully tapping 
into the potential of this methodology. 
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APPENDIX A) Metadata / Data Capture Template: “AppendixA_Spectral_Metadata.xlsx”. 

APPENDIX B) TSG templates and ioGAS color legend: “AppendixB_TSG_templates.zip”. 

APPENDIX C) Case Studies in the Literature 
 
Numerous studies on the application of SWIR methods to mineral exploration can be found in 
the public domain and we encourage new users to explore the existing body of work. The 
following table suggests some (of many) further readings and highlights relevant observations. 
 

Year Reference Acquisition Type Synopsis Observations 
2001 Mapping Porphyry-

Skarn Alteration at 
Yerington, Nevada, 
Using Airborne 
Hyperspectral VNIR-
SWIR-TIR Imaging 
Data (Cudahy et al., 
2001) 

Airborne (HyMap) and 
Satellite (SEBASS) 

Case study at 
Yerington, Nevada, a 
well exposed porphyry 
copper and skarn 
system. Illustrates the 
integrated 
interpretation of 
airborne and satellite-
borne data streams, 
covering a broad 
wavelength range 
(VNIR-SWIR-TIR).  

Useful to involve data 
from beyond the SWIR 
range (e.g., VNIR and 
TIR) when possible, 
and apply higher 
resolution methods 
(HyMap) to 
complement lower 
resolution methods 
(SEBASS). In this case 
mineral zonation is 
observed in the results 
(white mica and 
chlorite chemistry from 
the SWIR range). 

2008 An overview of VIS-
NIR-SWIR field 
spectroscopy as applied 
to precious metals 
exploration (Hauff, 
2008) 

Field Portable Extremely 
comprehensive 
overview of SWIR 
methods in the context 
of precious metals 
exploration. Numerous 
real-world examples. 

Very comprehensive 
document. Good 
summary of SWIR 
active minerals and 
their relationship with 
various deposit types. 

2013 Shortwave Infrared 
Spectral Analysis of 
Hydrothermal 
Alteration Associated 
with the Pebble 
Porphyry Copper-Gold-
Molybdenum Deposit, 
Iliamna, Alaska 
(Harraden et al., 2013) 

Field Portable SWIR results from 
acquisition on drill-
core at this significant 
porphyry deposit 
discussed. 
Characterization of 
alteration assemblages 
and geometry using 
these methods. 

Clear relationship 
between low W2200 
values and higher Au-
Cu grades. Case made 
for the utility of SWIR 
analysis in constraining 
3D geometry. 

2015 Footprints: 
Hydrothermal 
Alteration and 
Geochemical 
Dispersion Around 
Porphyry Copper 
Deposits (Halley et al., 
2015) 

Field Portable Overview of the results 
of a consortium project 
studying zonation 
around porphyry 
copper deposits in 
mineralogical and 
geochemical terms. 

Useful schematic 
diagrams illustrating 
mineralogical zonation 
as well as W2200 
contours around an 
idealized porphyry 
model. Linkages 
between this and 
pathfinder 
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geochemistry are 
explored. 

2017 Porphyry Copper 
Targeting Under 
Gravel Cover in 
Northern Chile (Wood 
and Trott, 2017) 

Field Portable Integration of multiple 
datasets for exploration 
below post-mineral 
cover (including SWIR 
results from sparse 
outcrop). Example 
from northern Chile. 

Illustrates fusion of 
geochemical alteration 
classification (GER-
based) with SWIR 
results to constrain 
facies. 

2018 NIR Characteristics of 
Porphyry Copper 
Deposits (Jansen and 
Trott, 2018) 

Field Portable Overview of SWIR 
response for the 
Haquira East (Peru) 
and Taca Bajo 
(Argentina) porphyry 
deposits, and an 
anonymous Chilean 
porphyry prospect. 
Generalization of some 
scalar vectors and 
SWIR-active alteration 
minerals.  

Useful schematic 
diagrams showing 
mineralogical zonation 
with spectral activity in 
a porphyry scenario. 
Discusses some 
potentially misleading 
scenarios where 
smectite influence may 
impact white mica 
crystallinite and 
W2200 vectors 
(Haquira), or isotherm 
collapse and later 
overprinting (Taca 
Taca). 

2018 Spectral characteristics 
of propylitic alteration 
minerals as a vectoring 
tool for porphyry 
copper deposits (Neal 
et al., 2018) 

Field Portable  Study of spectral 
response of chlorite-
bearing rocks from the 
Batu Hijau porphyry 
Cu-Au deposit 
(Indonesia) and 
systematic variation as 
a function of distance 
to system center. 

Firmly links the Mg# in 
chlorite to the W2250 
and W2340, and 
subsequent zonation 
with regard to the Batu 
Hijau hydrothermal 
footprint.  

2018 The Valeriano 
Porphyry Copper 
Deposit Revisited: 3D 
Geological/Geochemic
al Integration and 
Characterization (Trott 
et al., 2018) 

Field Portable Integration of SWIR 
mineralogy with 
geochemical data to 
understand system 
evolution and zonation 
patterns in the case of 
the Valeriano porphyry 
(Chile). 

The youngest 
hydrothermal event is 
the most prominent. 
Case made for 
integration of SWIR 
results with 
geochemistry. 

2021 Using hyperspectral 
imagery for 
identification of 
pyrophyllite-muscovite 
intergrowths and 
alunite in the shallow 
epithermal environment 
of the Yerington 
porphyry copper 

Field Portable and 
Airborne 

Detailed study of 
muscovite replacement 
of pyrophyllite in the 
advanced argillic 
environment in the 
Yerington district 
(Nevada), linking 
textural observations in 
the laboratory to 

Proposal of novel 
index, the pyrophyllite-
muscovite index (PMI) 
intended to identify 
areas where 
pyrophyllite from the 
advanced argillic 
assemblage has been 
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deposit (Portela et al., 
2021) 

airborne hyperspectral 
data. 

partially replaced by 
muscovite. 
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